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1. Einfihrung

Sehr geehrte Kundin, sehr geehrter Kunde,

Vielen Dank fir den Kauf dieses Produkts.

Dieses Produkt erfilllt die gesetzlichen nationalen und européischen Anforderungen.

Um diesen Status zu erhalten und einen sicheren Betrieb zu gewahrleisten, missen Sie als Anwender diese
Betriebsanleitung beachten!

Diese Bedienungsanleitung ist Teil dieses Produkts. Sie enthalt wichtige Hinweise zur Inbetriebnahme und
Handhabung. Bedenken Sie dies auch, wenn Sie das Produkt an Dritte weitergeben. Bewahren Sie diese
Bedienungsanleitung daher zu Nachschlagezwecken auf!

Bei technischen Fragen wenden Sie sich bitte an:
Deutschland: ~ www.conrad.de

Osterreich: www.conrad.at

Schweiz: www.conrad.ch

2. Symbol-Erklarungen

Das Symbol mit dem Blitz im Dreieck wird verwendet, wenn Gefahr fiir Inre Gesundheit besteht, z.B. durch
elektrischen Schlag.

Das Symbol mit dem Ausrufezeichen im Dreieck weist auf wichtige Informationen in dieser
Bedienungsanleitung hin. Lesen Sie diese Informationen immer aufmerksam.

—> Das Pfeilsymbol weist auf besondere Informationen und auf Ratschlége zur Bedienung hin.

3. BestimmungsgemaRe Verwendung

Bei diesem Produkt handelt es sich um ein eigenstandiges Gerat, das mit einem wiederaufladbaren Akku betrieben
wird. Es kann ein vergroRertes Bild Uber das eingebaute Display, einen Fernseher oder einen Computermonitor
wiedergeben. Es eignet sich zur Untersuchung von festen Objekten wie Minzen, Briefmarken, Steinen, Insekten,
Pflanzen, Textilien, Leiterplatten usw. Als Lichtquelle dienen dimmbare LED-Leuchten und die mitgelieferte Software
ermdglicht dem Benutzer, das Mikroskop zu kalibrieren und die GroRe von aufgenommenen Bildern zu messen.

Das Gerét ist nur fir den Innengebrauch geeignet. Nicht im Freien verwenden. Der Kontakt mit Feuchtigkeit, z. B. im
Badezimmer, ist unbedingt zu vermeiden.

Aus Sicherheits- und Zulassungsgriinden diirfen Sie dieses Produkt nicht umbauen und/oder verander. Falls Sie
das Produkt fir andere als die zuvor genannten Zwecke verwenden, kénnte das Produkt beschédigt werden. Dartiber
hinaus ist dies mit Gefahren, wie z. B. Kurzschluss, Brand, elektrischer Schlag usw. verbunden. Lesen Sie sich die
Bedienungsanleitung genau durch und bewahren Sie diese auf. Reichen Sie das Produkt nur zusammen mit der
Bedienungsanleitung an dritte Personen weiter.

Alle enthaltenen Firmennamen und Produktbezeichnungen sind Warenzeichen der jeweiligen Inhaber. Alle Rechte vorbehalten.
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4. Lieferumfang

+ Hauptgerét + USB-Kabel
* Netzteil + AV-Kabel
« Kalibrierlineal * Li-lonen-Akku

+ Bedienungsanleitung

——> Eine microSD-Karte ist nicht im Lieferumfang enthalten.

Aktuelle Bedienungsanleitungen

Laden Sie aktuelle Bedienungsanleitungen Uber den Link www.conrad.com/downloads herunter
oder scannen Sie den abgebildeten QR-Code. Befolgen Sie die Anweisungen auf der Webseite.

5. Eigenschaften und Funktionen

3,5-Zoll-TFT-Display
+ 20 x - 500 x VergroRerung

5 Megapixel Bildsensor (12 MP interpoliert)

Foto und Videoaufnahme

Unterstlitzung von microSD-Karten (max. 32 GB)

Wiederaufladbarer Lithium-lonen-Akku

Unterstiitzung fiir Plug-and-Play.

PortableCapture Plus-Software

6. Systemvoraussetzung

+ Betriebssystem: Windows® Vista/7/8/10; Mac OS 10.9-10.13
+ CPU: Pentium 300 oder kompatibler AMD-Prozessor

+ 100 MB freier Festplattenspeicher

+ 512 MB RAM

+ 24-Bit-Grafikkarte

+ Freier USB 2.0-Anschluss



7. Sicherheitsanweisungen

N

Lesen Sie die wichtigen Informationen und die Bedienungsanleitung sorgféltig durch und beachten
Sie inshesondere die Sicherheitshinweise. Falls Sie die Sicherheitshinweise und Informationen fiir
einen ordnungsgemaBen Gebrauch in dieser Bedienungsanleitung nicht beachten, haften wir nicht fiir
moglicherweise daraus resultierende Verletzungen oder Sachschaden. Auerdem erlischt in solchen
Fallen die Gewahrleistung/Garantie.

a) Allgemein
Das Produkt ist kein Spielzeug. Halten Sie es von Kindern und Haustieren fern.

Lassen Sie das Verpackungsmaterial nicht achtlos liegen. Dieses kénnte fiir Kinder zu einem gefahrlichen
Spielzeug werden.

Schitzen Sie das Produkt vor extremen Temperaturen, direkter Sonneneinstrahlung, starken
Erschiitterungen, hoher Luftfeuchtigkeit, Feuchtigkeit, brennbaren Gasen, Dampf und Lésungsmitteln.

Setzen Sie das Produkt keiner mechanischen Beanspruchung aus.

Wenn kein sicherer Betrieb mehr méglich ist, nehmen Sie das Produkt auBer Betrieb und schiitzen
Sie es vor unbeabsichtigter Verwendung. Der sichere Betrieb ist nicht mehr gewahrleistet, wenn das
Produkt:

- sichtbare Schaden aufweist,

- nicht mehr ordnungsgeman funktioniert

- Uber einen langeren Zeitraum unter ungiinstigen Umgebungsbedingungen gelagert wurde oder
- erheblichen Transportbelastungen ausgesetzt wurde.

Gehen Sie vorsichtig mit dem Produkt um. St6RRe, Schldge oder sogar das Herunterfallen aus geringer
Héhe kdnnen das Produkt beschadigen.

Beachten Sie auch die Sicherheitshinweise und Bedienungsanleitungen der iibrigen Geréte, an die das
Produkt angeschlossen wird.

Wenden Sie sich an einen Experten, wenn Sie Zweifel an der Funktion, Sicherheit oder in Bezug auf den
Anschluss des Produkts haben.

Wartung, Modifikationen und Reparaturen diirfen nur von einem Techniker oder einer autorisierten
Reparaturwerkstatt durchgefihrt werden.

Sollten Sie noch Fragen haben, die in dieser Bedienungsanleitung nicht beantwortet werden, wenden
Sie sich an unseren technischen Kundendienst oder an andere Fachleute.

Achtung, LED-Licht:
- Nicht direkt in das LED-Licht blicken!
- Nicht direkt oder mit optischen Instrumenten in den Strahl sehen!

In Schulen, Ausbildungsstatten, Hobby- oder Selbstbedienungswerkstatten muss der Umgang mit
elektrischen Geraten durch geschultes Personal iberwacht werden.

Bei Betrieb in gewerblichen Einrichtungen sind die einschldgigen Unfallverhitungsvorschriften der
Berufsgenossenschaften fiir elektrische Betriebsmittel zu beachten.

b) Akku
+ Achten Sie beim Einlegen des Akkus auf die richtige Polung.

+ Entfernen Sie die Batterie / den Akku, wenn Sie das Gerat langere Zeit nicht verwenden, um
Beschadigungen durch Auslaufen zu vermeiden. Auslaufende oder beschédigte Batterie / Akkus konnen
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bei Hautkontakt Saureveratzungen hervorrufen. Beim Umgang mit beschadigten Batterien / Akkus
sollten Sie daher Schutzhandschuhe tragen.

+ Bewahren Sie Batterie / Akkus auRerhalb der Reichweite von Kindern auf. Lassen Sie Batterie / Akkus
nicht frei herumliegen, da diese von Kindern oder Haustieren verschluckt werden kénnten.

+ Akku dirfen nicht demontiert, kurzgeschlossen oder ins Feuer geworfen werden. Versuchen Sie
niemals, nicht aufladbare Batterie aufzuladen. Es besteht Explosionsgefahr!

+ Laden Sie den Akku nicht iiber das Stromnetz auf, solange das Mikroskop an einem mit Strom versorgten
USB 2.0-Anschluss angeschlossen ist. Dies kann zur Uberhitzung der Batterie fiihren.

c¢) Netzteil

Die Netzsteckdose muss sich in der Nahe des Gerats befinden und leicht zuganglich sein.

Als Spannungsquelle darf nur das beiliegende Netzteil verwendet werden.

Als Spannungsquelle fir das Netzteil darf nur eine ordnungsgeméfe Netzsteckdose des offentlichen
Versorgungsnetzes verwendet werden. Uberprifen Sie vor dem Einstecken des Netzteils, ob die
auf dem Netzteil angegebene Spannung mit der Spannung lhres Stromversorgungsunternehmens
Ubereinstimmt.

Netzteile diirfen nie mit nassen Handen ein- oder ausgesteckt werden.

Ziehen Sie Netzteile nie an der Leitung aus der Steckdose, ziehen Sie sie immer nur an den dafir
vorgesehenen Criffflachen aus der Netzsteckdose.

Stellen Sie sicher, dass beim Aufstellen das Kabel nicht gequetscht, geknickt oder durch scharfe Kanten
beschadigt wird.

Verlegen Sie Kabel immer so, dass niemand Uber diese stolpern oder an ihnen héngen bleiben kann.
Es besteht Verletzungsgefahr.

Ziehen Sie aus Sicherheitsgriinden bei einem Gewitter immer das Netzteil aus der Netzsteckdose.

d) Mikroskop

Untersuchen  Sie  keine  Objekte, die Temperaturen auferhalb des angegebenen
Betriebstemperaturbereichs des Produkts aufweisen.

Plétzliche Temperaturanderungen kénnen dazu fihren, dass sich im Inneren des Mikroskops Tau bildet
- wie im kalten Winter in einen warmen Raum. Legen Sie es in eine Handtasche oder eine Plastiktite,
um Temperaturdnderungen zu verlangsamen.

Richten Sie das Objektiv des Mikroskops nicht lange auf die Sonne oder starkes Licht. Starkes Licht
kann die lichtempfindliche Elektronik beschadigen.

Setzen Sie die Karte nicht mit Gewalt in den Steckplatz ein, da dies das Mikroskop und die microSD-
Speicherkarte beschadigen kann.

Der StandfuR des Mikroskops kann Spuren auf empfindlichen Oberflachen hinterlassen.

e) Schutz vor Staub
+ Staub und Ablagerungen aus der Luft kdnnen zu einer Verschlechterung der Bildqualitat fiihren. Halten
Sie das Mikroskop von staubigen Umgebungen fern.

+ Die Offnung des Kameraobjektivs sollte immer entweder mit Staubschutzhauben o. 4. bedeckt werden.
Geeignete Optionen sind z. B. Aluminiumfolie oder Plastikbeutel.

+ Wenn dunkle Flecken oder ahnliche Partikel auf den digitalen Bildern zu sehen sind und diese sich nicht
Probenplatte befinden, ist die wahrscheinlichste Ursache dafiir eine Partikelverunreinigung auf dem
Bildsensor oder einer zugeordneten Filteroberflache. Die Kameras miissen nach den Empfehlungen des
Herstellers immer mit grofter Sorgfalt behandelt und vor Verschmutzung geschiitzt werden.

« Uberpriifen Sie vor jedem Einsatz die Frontlinse des Objektivs auf Verschmutzung.



8. Bedienelemente

a) Bedienelemente

= =
o) 00013/01E18
= STON]
Regelung der
= =
L 0 sl >_ LED-Beleuchtung
x1.8
microSD-— p—Heran- und
Kartensteckplatz Herauszoomen
Wiedergabel/links Produkt EIN-/AUSSCHALTEN
Einrichtungsmenii Nach unten
Bestatigen Farbmodus/hoch

b) Symbole auf dem LCD-Display

Bedien- taste Beschreibung
@/ DE Standbild / Videomodus
@ Timermodus

.1]] ﬂ@ﬂ Anzahl der aufgenommenen / noch mdglichen Bilder (basierend auf der aktuellen

Bildauflosung und der GroRe der microSD-Karte).

@ MicroSD-Karte eingesetzt
SO Aktuelle Bildaufldsung
Akkustand

x1.5 Digitale Zoomstufe




c¢) Mikroskop

©

©

@ el )

©

‘ A6

S| Mr
O I

j—; —;
A1 3,5-Zoll-Display A9  AV-out (AV-Ausgang) fiir Fernseher
A2 microSD-Kartensteckplatz A10 USB 2.0 Mini-B
A3 Feinfokussierrad A11 Helligkeitseinstellung fiir die LED-Beleuchtung
A4 Objekthalter A12 Digitaler Zoom +/-
A5  Grobtrieb (Verriegelung) A13 Kameraobjektiv/ILED-Lichtquelle
A6 Batterieanzeige-LED A14  Grobtrieb (hoch/runter)
A7  Bildaufnahme-Taste A15 Batteriefach

A8 5VIDC-Ladeanschluss

Die GummifiRe an der Unterseite des Mikroskops kénnen Spuren auf empfindlichen Oberflachen
hinterlassen.



9. Einrichten des Mikroskops

a) Einlegen des Akkus
+ Achten Sie dabei auf die im Batteriefach (A15) abgebildete Polaritat.
=

b) Laden des Akkus

Laden Sie den Akku nicht tiber das Netzteil auf, wahrend das Mikroskop an einen mit Strom versorgten
USB 2.0-Anschluss angeschlossen ist. Dies kann zur Uberhitzung der Batterie fiihren.

+ Der Akku kann (iber ein USB-Kabel oder ein
Netzteil aufgeladen werden.

‘ - Schlieffen Sie das mitgelieferte Ladekabel
00 an den 5V / DC- Ladeanschluss (A8) an der
/ Rickseite des Standfufes und das andere
ol Ende an eine Steckdose an.

- Oder schlieflen Sie das mitgelieferte USB-Kabel
an den USB-Anschluss (A10) auf der Riickseite
der StandfuRes und das andere Ende an den
USB-Anschluss Ihres Computers an.

+ Die Batterieanzeige-LED (A6) leuchtet rot, um
anzuzeigen, dass der Akku geladen wird, und
erlischt, wenn der Akku vollstandig geladen ist.

Wenn es an der Zeit ist, den Akku wieder
aufzuladen, erscheint in der unteren rechten
Ecke des LCD-Displays das Symbol fiir niedrigen
Batteriestand
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c) Einsetzen der microSD-Karte

Driicken Sie die Karte nicht mit Gewalt in den microSD-Kartensteckplatz (A2), da dies das Mikroskop
und die Speicherkarte beschadigen kann. Die microSD-Speicherkarte muss vor dem Gebrauch formatiert
werden (siehe Abschnitt ,11.c Allgemeines / SD-Karte formatieren®).

+ Wenn Sie das Mikroskop verwenden mdchten, ohne es an einen
Computer anzuschlieRen, missen Sie eine microSD-Karte (nicht
im Lieferumfang enthalten) einstecken.

+ Trennen Sie das Mikroskop vom Strom und schalten Sie es aus.

+ Stecken Sie die microSD-Karte wie unten gezeigt ein.

—> Siehe Abschnitt ,12. Mit einem Computer verbinden® fiir Informationen zum AnschlieBen des Mikroskops
an einen Computer.

10. Betrieb

& Decken Sie das Mikroskop nicht ab, wenn es in Gebrauch ist.

a) Produkt EIN-/AUSSCHALTEN

+ Driicken Sie die Taste (1), um das Mikroskop ein- oder auszuschalten.

b) Scharfstellen des Mikroskops

+ Legen Sie das zu untersuchende Objekt auf die Ablage (A4) . Wenn Sie Dias oder ahnliches anschauen wollen,
befestigen Sie sie mit den Clips auf der Ablage.

+ Halten Sie den Grobtrieb (A14) fest und I6sen Sie die Verriegelung des Grobtriebs (A5).
+ Drehen Sie das Grobfokussierrad (A14), um das Objektiv zum Objekt hin abzusenken.

+ Stellen Sie das Feinfokussierrad (A3) ein, um das Bild scharf zu stellen.

—> Es kann einige Augenblicke dauern, bis der WeiRabgleich sich automatisch einstellt und das Bild scharf
stellt. Wenn das Objekt zu stark reflektiert, sollten Sie die Helligkeit der LED-Beleuchtung (A4) verringern
oder vollstandig ausschalten.
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c) Starke und geringe VergroRerung
+ Zentrieren Sie die Linse (A13) Uber dem Objekt.

« Starke VergroRerung: Drehen Sie das Feinfokussierrad (A3) ganz nach rechts und drehen Sie dann langsam
zurlick, bis das Bild scharfgestellt ist.

+ Geringe VergroRerung: Drehen Sie das Feinfokussierrad (A3) ganz nach links und drehen Sie dann langsam
zuriick, bis das Bild scharfgestellt ist.

——> Nachdem Sie den Feintrieb (A3) ganz nach rechts oder links gedreht haben, dauert es einige Sekunden,
bis sich die LED-Beleuchtung wieder korrekt eingestellt hat.

d) Digitaler Zoom
+ Stellen Sie zuerst das Objekt auf dem LCD-Display (A1) scharf.

+ Zoomen Sie an das Objekt heran oder von ihm weg, indem Sie am Zoom-Rad = b + (1x - 4,0x) drehen.

e) Foto-/Videoaufnahme
+ Driicken Sie, © < um zwischen Foto- und Videomodus zu wechseln.
- Das Symbol (S auf dem LCD-Display zeigt an, dass Sie sich im Fotomodus befinden.
- Das Symbol =) auf dem LCD-Display zeigt an, dass Sie sich im Videomodus befinden.
+ Driicken Sie die Aufnahmetaste (], um ein Foto zu machen oder um ein Video aufzunehmen.

+ Wenn Sie ein Video aufnehmen, driicken Sie die Aufnahmetaste (2] erneut, um die Aufnahme zu stoppen.

f) Foto-/Videovorschau

+ Driicken Sie die Taste D 4, um in den Wiedergabemodus zu gelangen.

+ Driicken Sie A oder ¥, um ein Foto oder Video zur Ansicht auszuwahlen.
- Das Symbol £ auf dem LCD-Display zeigt an, dass es sich um ein Video handelt.
- Das Symbol () auf dem LCD-Display zeigt an, dass es sich um ein Foto handelt.

+ Drlicken Sie OK, um ein Video abzuspielen.

g) Wiedergabeoptionen
+ Driicken Sie die Taste D 4, um in den Wiedergabemodus zu gelangen.
+ Driicken Sie A oder V, um ein Foto oder Video zur Ansicht auszuwahlen.
+ Drlicken Sie ‘, um in das Untermenii zu gelangen. Driicken Sie dann A oder 'V fiir weitere Optionen wie:
- Léschen: Léscht das Bild.
- Schutzen: Sperrt ein oder alle Bilder, um zu verhindern, dass sie versehentlich geléscht werden.
- Diashow: Zeigt alle gespeicherten Fotos nacheinander an. Die Diashow endet, nachdem alle Fotos angezeigt wurden.

+ Drlicken Sie OK, um eine Option auszuwahlen.
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h) Farbmodi

Wechseln Sie im Fotomodus zu den Farbmodi (©J; indem Sie die Taste M A zum Wechseln zwischen Farbe /
Positiv / Negativ drlicken.

—> Sie kénnen die Farbmodi fiir die Videoaufnahme nicht &ndern.

11. Einstellungsmaglichkeiten im Mikroskopmenii

Um auf die Foto- oder Videoeinstellungen zuzugreifen, driicken Sie zuerst ©> <, um einen Modus auszuwahlen.
- Das Symbol (S] auf dem LCD-Display zeigt an, dass Sie sich im Fotomodus befinden.

- Das Symbol I3 auf dem LCD-Display zeigt an, dass Sie sich im Videomodus befinden.

Driicken Sie \, um auf die Einstellungen zuzugreifen.

Driicken Sie > <, um zwischen Kamera und allgemeinen Einstellungen zu wechseln.

Driicken Sie A oder ¥, um nach oben oder unten zu scrollen. Driicken Sie OK, um eine Option auszuwahlen.

Driicken Sie \, um die Einstellungen zu verlassen.

a) Kamera [©)

Aufldsung: Einstellen der Bildauflésung. Je hoher die Aufldsung ist, desto mehr Speicherplatz nimmt jedes Bild in
Anspruch.

Zeitraffer:

- Bilder: Festlegen der Gesamtzahl der Bilder, die aufgenommen werden sollen.

- Dauer: Festlegen des Zeitabstands zwischen den aufgenommenen Bildern (hh: mm: ss).

- Drlicken Sie %, um die Einstellungen zu verlassen.

- Die Zeitrafferaufnahme wird automatisch gestartet und das LCD-Display zeigt das Zeitraffer-Symbol = an.

- Die Zeitrafferaufnahme wird beendet, nachdem die festgelegte Gesamtzahl der Bilder aufgenommen wurde,
indem Sie auf OK oder (&] driicken.

Scharfe: Sie kdnnen die Bildscharfe des Bildes auf dem LCD-Display mithilfe der Software verandern (hart, normal,
weich).

b) Video |3

Auflésung: Einstellen der Aufldsung (VGA oder QVGA)

13



c) Allgemein %

Sprache: Einstellen der Displaysprache

Energiesparmodus: Einstellen der automatische Abschaltzeit ein, wenn keine Tasten fiir (5, 10, 15) Minuten
gedrlickt werden.

Frequenz: Einstellen der Flimmerfrequenz: 50 Hz oder 60 Hz.
Datumsstempel:
- Gehen Sie zuerst zu ,Datum/Uhrzeit* und stellen Sie die aktuelle Uhrzeit und das Datum ein.

- Wenn Sie Einstellungen in ,Datum/Uhrzeit* vornehmen, werden alle lhre Foto- und Videoaufnahmen mit einem
Datums- und Zeitstempel versehen.

TV-Ausgang: Auswahl zwischen PAL oder NTSC

Datum/Uhrzeit: Einstellen des aktuellen Datums und der Uhrzeit.

SD-Karte formatieren: Loscht alle Bilder auf der SD-Karte/bereitet eine neue SD-Karte fiir die Verwendung vor.
Sys. Reset: Stellt alle Einstellungen auf die Werkseinstellungen zurtick.

Version: Zeigt die installierte Firmware-Version an.

12. Verbindung zu einem Computer herstellen

Mit der im Lieferumfang befindlichen Software ,PortableCapture Plus* kdnnen Sie eine Vorschau von Bildern auf
Ihrem Computer anzeigen, Ihr Mikroskop vollstandig steuern und vieles mehr. Weitere Informationen finden Sie im
Abschnitt ,PortableCapture Plus-Software®.

14



Verbinden Sie ein Ende des mitgelieferten USB-Kabels mit dem USB-Anschluss Feinfokussierrad (A10) an lhrem
Mikroskop und das andere Ende mit einem freien USB 2.0-Anschluss an lhrem Computer.

Driicken Sie die Taste (1), um das Mikroskop einzuschalten.

Driicken Sie A oder ¥ und wahlen Sie PREVIEW ON COMPUTER (VORSCHAU AUF COMPUTER). Driicken
Sie dann auf OK.

Flhren Sie die Software aus, indem Sie nach der Installation auf dem Desktop auf das Symbol ,PortableCapture
Plus* klicken.

—> Wenn Sie das Mikroskop tiber die Computer-Software steuern, werden die Hardwaretasten deaktiviert, da
die meisten Funktionen tber die Software ,PortableCapture Plus* verfiigbar sind.

13. Herunterladen und Installation der Software

a) Windows®-Installation

Portable Stand Alone
LCD Digital Microscope

Insizll PartableCapture
User's manual

Browsa the GO

ok E Sl

1. Rufen Sie die URL-Adresse www.conrad.com/downloads auf.
2. Geben Sie dann die Artikelnummer 1713199 in das Suchfeld ein.

3. Wahlen Sie Install PortableCapture (PortableCapture installierena) aus, um die Software zu installieren, und
befolgen Sie die Anweisungen auf dem Bildschirm, um den Installationsvorgang abzuschlieRen.

4. Fiihren Sie die Software aus, indem Sie nach der Installation auf dem Desktop auf das Symbol ,PortableCapture
Plus*” klicken.

—>  Andern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English
(Englisch).
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b) MacOS-Installation

Rufen Sie die URL-Adresse www.conrad.com/downloads auf.

Geben Sie dann die Artikelnummer 1713199 in das Suchfeld ein.

Wahlen Sie die Datei PortableCapture Plus.pkg aus.

Befolgen Sie die Anweisungen auf dem Bildschirm, um den Installationsvorgang abzuschlieRen.

Fuhren Sie die Software aus, indem Sie nach der Installation auf dem Desktop auf das Symbol ,PortableCapture
Plus* klicken.

——>  Andemn Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English
(Englisch).

ok~ DD~

c) Ubersicht

£) PortableCapture Plus

Bl ——— "=t options Captura Help
B 950 eWwe T e B
Photo | Video
180814180443732/p9
B3
B7
B4——
5407480

B1 Meniipunkte

- File (Datei) > Photos (Fotos) / Videos Folder (Video-Ordner): Hier werden erfasste Bilder auf lnrem Computer
gespeichert.

- Options (Optionen) > Resolution (Aufldsung): Andern der Aufldsung der aufgenommenen Bilder

- Options (Optionen) > Resolution (Auflésung): Ein-/Ausblenden des Datums-/Uhrzeitstempel auf einem Foto
oder in einem Video

- Options (Optionen) > Language (Sprache): Einstellen der Sprache fiir die Benutzeroberflache
- Options (Optionen) > XY Guide (XY-Hilfslinien): Hilfslinien anzeigen/ausblenden
B2 Shortcuts: Kamera / Video / Timer / Vollbild

Qevw
Wechseln Sie in den Vollbildmodus oder beenden Sie ihn, indem Sie auf den Vorschaubereich doppelklicken oder
das Vollbild-Symbol auswahlen.

B3 X- und Y-Achsen-Hilfslinien
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B4 Bildvorschaubereich
B5 VergroRerungsinformationen
B6 Foto/Video-Registerkarte: Wahlen Sie eine Registerkarte aus, um gespeicherte Fotos oder Videos anzuzeigen.
B7 Fenster fiir gespeicherte Bilder (Miniaturansicht)
- Aufgenommene Bilder/Videos werden als Miniaturansichten angezeigt.
- Wenn Sie mit der Maus Uber eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4).

- Klicken Sie mit der rechten Maustaste auf ein Bild, um weitere Optionen anzuzeigen, z. B. Open (Offnen), Save
as (Speichern unter), Copy (Kopieren), Delete (Loschen), Delete All (Alle Idschen).

d) Fotos aufnehmen

+ Stellen Sie das Mikroskop so ein, dass das Kameraobjektiv (A3) nahe am Objekt liegt und auf dieses zeigt.
+ Stellen Sie sicher, dass sich das zu untersuchende Objekt unter dem Objektiv befindet.

+ Wahrend Sie den Bildvorschaubereichs (B4) betrachten, stellen Sie das Bild scharf.

* Um ein Bild aufzunehmen, wahlen Sie das Kamera-Shortcut-Symbol (g aus oder driicken Sie die
Bildaufnahmetaste (A7).

+ Die Fotos werden in File (Datei) > Photos Folder (Fotoordner) gespeichert.

—> Aufgenommene Bilder werden als Miniaturansichten im Fenster fiir gespeicherte Bilder angezeigt (B7).
Wenn Sie mit der Maus Uber eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4).
Bilder werden im JPG-Format gespeichert.

e) Videos aufnehmen

+ Stellen Sie das Mikroskop so ein, dass das Kameraobjektiv (A3) nahe am Objekt liegt und auf dieses zeigt.
+ Stellen Sie sicher, dass sich das zu untersuchende Objekt unter dem Objektiv befindet.

+ Wahrend Sie den Bildvorschaubereichs (B4) betrachten, stellen Sie das Bild scharf.

+ Um mit der Aufnahme zu beginnen, wéhlen Sie das Video-Shortcut-Symbol &' aus. Das Symbol blinkt, um
anzuzeigen, dass die Aufnahme gestartet wurde.

Klicken Sie auf das blinkende Symbol, um die Aufzeichnung zu stoppen.

Videos werden in File (Datei) > Videos Folder (Videoordner) gespeichert.

——> Aufgenommene Videos werden als Miniaturansichten im Fenster fiir gespeicherte Bilder angezeigt (B7).
Wenn Sie mit der Maus tber eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4).
Videos werden im AVI-Format gespeichert.
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f) Foto- und Video-Timer

& Timer
@® Photo

StarTime
Interval(sec):
Video time(sec).

Total Number.

Captured Number:

Start

O Video

2018/08/07 15:13:22 ~

10

X

Stop

g) Bildmesswerkzeuge

+ Sie kdnnen einen benutzerdefinierten Start- und Stopptimer fiir die Aufnahme
von Fotos oder Videoaufnahmen einstellen.

+ Wahlen Sie das Timer-Shortcut-Symbol & aus und wéhlen Sie dann Photo
(Foto) oder Video.

+ Nehmen Sie die gewiinschten Einstellungen vor.

+ Wahlen Sie Start aus, um mit der Aufnahme zu beginnen.

——> Die Aufnahme stoppt, nachdem das Programm die Parameter

durchlaufen hat oder wenn Sie Stop (Stopp) wéhlen, um den Timer
zu beenden. Stellen Sie vor der Aufnahme sicher, dass Sie geniigend
Speicherplatz auf lhrer Festplatte haben.

Um die Genauigkeit der Messwerkzeuge sicherzustellen, kalibrieren Sie zuerst |hr Mikroskop. Siehe
Abschnitt ,14“. Kalibrieren des Mikroskops®, um weitere Informationen dazu zu erhalten.

—> Doppelklicken Sie auf ein Bild im Fenster fiir gespeicherte Bilder (B7), um die Oberflache fiir Bildmessung
aufzurufen, und wahlen Sie dann das Messsymbol =77 aus.
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k= Any Angle Line
B Continuous Line
%) Radius Circle
) Diameter Circle
-

Three Points Angle

Line Properties

3

Continuous Line Measurement (Kontinuierliche Linienmessung).
Klicken und ziehen Sie von einem Punkt zum anderen.

Continuous Line Measurement (Kontinuierliche Linienmessung).
Klicken und ziehen Sie von einem Punkt zu mehreren Punkten.

Radius Circle Measurement (Radiuskreismessung). Klicken und ziehen
Sie, um den Radius zu vergroRern.

Diameter Circle Measurement (Durchmesserkreismessung). Klicken und
ziehen Sie, um den Durchmesser zu vergréern.

Three Points Angle Measurement (Drei-Punkte-Winkelmessung).
Klicken und ziehen Sie von einem Punkt zum anderen, messen Sie den
Winkel, und klicken Sie dann mit der Maus, um loszulassen.



h) Zeichnen und Text

——> Doppelklicken Sie auf ein Bild im Fenster fiir gespeicherte Bilder (B7), um die Oberflache fiir Bildmarkierung/
Kommentare aufzurufen, und wahlen Sie dann das Symbol @ zum Zeichnen aus.

y q + Ein Dropdown-Men(i mit verschiedenen Optionen wird angezeigt.

= % Line
Arrow

Freehand

Ow

Rectangle

Line Properties  »

+ In den Line Properties (Linieneigenschaften) konnen Line Width
[— Solid line - ] (Linienbreite) und Line Color (Linienfarbe) angepasst werden.

2 %] Line Width

[ Line Color

ﬁ + Um die Textoptionen zu ander, wahlen Sie das Symbol I fiir Text aus.
i + Ein Dropdown-Menii mit verschiedenen Optionen wie Schriftart und
T Choose Font Textfarbe wird angezeigt.

Il Tt Color
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14. Kalibrieren des Mikroskops

- + Fokussieren Sie das Mikroskop auf das Kalibrierungslineal.
T n |
T ) Hull ‘ i \ ] m \ + Drehen Sie das Feinfokussierrad (A3), bis das Bild scharf wird.

Oin

Calibration Ruler Lme

BER

mm nms 01 02 03 04 08

Stellen Sie die Linealposition so ein, dass das Bild auf
die XY-Hilfslinien ausgerichtet ist.

Magnification: None
Photo | video

—> Doppelklicken Sie auf ein Bild im Fenster fiir gespeicherte Bilder (B7), um die Oberfléche fir Bildmessung
aufzurufen, und wéhlen Sie dann das Symbol ", zum Kalibrieren aus.

[@0eeeee ¢ T = ||+ Klicken und ziehen Sie, um Start- und Endpunkte Gber
i einen bekannten Wert zu wahlen, z. B. 1 mm-Abschnitte
auf dem Lineal.

Wenn das Dialogfeld angezeigt wird, geben Sie den
genauen Wert der Messprobe in das Feld Actual
dimension (Tatsachliche Lange) ein. Die Software
berechnet die VergrofRerung.

Driicken Sie zur Bestatigung auf OK. Der eingestellte
VergroRerungswert wird in der oberen rechten Ecke
angezeigt.
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15. Verbindung mit einem Fernseher herstellen

Sie kdnnen lhren Fernseher als groRes Display zum Betrachten vergroRerter Objekte verwenden.

SchlieBen Sie das mitgelieferte AV-Kabel an den AV-out (AV-Ausgang) (A9) am Mikroskop und das andere Ende
an den Videoeingang Ihres Fernsehers an.

Driicken Sie die Taste (1), um das Mikroskop einzuschalten.

Driicken Sie £ <, um zwischen Foto- und Videomodus zu wechseln.

- Das Symbol (@] auf dem LCD-Display zeigt an, dass Sie sich im Fotomodus befinden.

- Das Symbol [ = auf dem LCD-Display zeigt an, dass Sie sich im Videomodus befinden.
Driicken Sie \ um auf die Mikroskopeinstellungen zuzugreifen.

Driicken Sie £ <, um zu ,Setup (Einrichtung)* zu wechseln.

Driicken Sie A oder ¥ und wéhlen Sie, TV Out (TV-Ausgang)“ aus. Driicken Sie dann auf OK.
Driicken Sie A oder ¥ und wahlen Sie NTSC" oder ,PAL" aus. Driicken Sie dann auf OK.
Driicken Sie ‘& um die Mikroskopeinstellungen zu verlassen.

Wahlen Sie den entsprechenden Eingangskanal an Ihrem Fernseher.

—> Informationen dariiber, wo Sie die Videoeingénge finden und wie Sie den Eingangskanal auswahlen,

finden Sie in der Bedienungsanleitung Ihres Fernsehgeréts.

16. Bildsicherung (USB-Modus)

——>  Sie konnen Bilder direkt auf lhrem Computer speichern, ohne die mitgelieferte Software zu verwenden.

Verbinden Sie ein Ende des mitgelieferten USB-Kabels mit dem USB-Anschluss (A10) an lhrem Mikroskop und das
andere Ende mit einem freien USB 2.0-Anschluss an lhrem Computer.

Driicken Sie die Taste (1), um das Mikroskop einzuschalten.

Wahlen Sie aus dem Meni heraus UPLOAD IMAGES (BILDER HOCHLADEN) aus und driicken Sie dann auf OK.
Das Mikroskop wird auf lhrem Computer als externes USB-Speichergerat USBSTORAGE angezeigt.

Waéhlen Sie den zutreffenden Laufwerksbuchstaben und gehen Sie zu den Ordnern Photo (Foto) oder VIDEO, um
auf lhre gespeicherten Bilder zuzugreifen.

Kopieren Sie Bilder in den gewlinschten Ordner auf Inrem Computer.
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17. Pflege und Reinigung

+ Trennen Sie das Produkt vor jeder Reinigung von lhrem Computer. Wenn es heild ist, warten Sie, bis es abgekiihlt
ist.

+ Verwenden Sie keine aggressiven Reinigungsmittel, Alkohol oder andere chemischen Losungsmittel, da diese zu
Schéden am Gehause und zu Fehlfunktionen flihren knnen.

+ Die LED-Beleuchtung ist nicht austauschbar.

Vermeiden Sie es, die Linse mit irgendwelchen Stoffen zu berlhren. Reinigen Sie die Linse regelmafig mit
niedrigerer Druckluft.

+ Verwenden Sie zum Reinigen des Produkts ein trockenes, faserfreies Tuch.

18. Entsorgung

a) Produkt

Elektronische Geréate sind Wertstoffe und gehéren nicht in den Hausmiill. Entsorgen Sie das Produkt
am Ende seiner Lebensdauer gemaf den geltenden gesetzlichen Bestimmungen. Entnehmen Sie evtl.
mmm  ©ingelegte Akkus und entsorgen Sie diese getrennt vom Produkt.

b) Akkus

Sie als Endverbraucher sind gesetzlich verpflichtet (Batterieverordnung), alle gebrauchten Akkus
zurlickzugeben. Eine Entsorgung tber den Hausmdll ist untersagt.

Schadstoffhaltige Akkus sind mit dem nebenstehenden Symbol gekennzeichnet, das auf das Verbot der
Entsorgung Uber den Hausmiill hinweist. Die Bezeichnungen fiir das ausschlaggebende Schwermetall
sind: Cd=Cadmium, Hg=Quecksilber, Pb=Blei (die Bezeichnung steht auf den Akkus z.B. unter dem links
abgebildeten Muilltonnen-Symbol).

Ihre verbrauchten Akkus kénnen Sie unentgeltlich bei den Sammelstellen |hrer Gemeinde, unseren Filialen oder
Uberall dort abgeben, wo Akkus verkauft werden!

Sie erfillen damit die gesetzlichen Verpflichtungen und leisten Ihren Beitrag zum Umweltschutz.
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19. Technische Daten

a) Mikroskop

SHOMVErSOrgUNG .....couvucereceereteeeeieeseeseeeenees Li-lon 3,7 V/ 1050 mAh (wiederaufladbarer Akku)
5V/DC, 500 mA (USB 2.0)

Ladezeit des Akkus ca. 2 Stunden (Uber Netzteil)

Akkulaufzeit ca. 2 Stunden

SPEICHET ..o microSD (max. 32 GB)

LCD-ANZEIGE ... 7,6 cm (3“) TFT, Seitenverhaltnis 4:3

BildSENSOr........ovviice 5MP

Videoauflosung..........c.evvreveeerceneiericrneieies VGAI

Kameraauflosung ...........cceeeveveeeinerineceneenne 12MP (4032 x 3024), 9M (3456 x 2592), 5MP (2560%1920),
3MP (2048x1536), 1,3MP (1280%960)

Farbe ..o 24-Bit RGB

Fokusbereich ... 10 mm (manueller Fokus)

VErgroRerung.........ceeevererereeererereeenierinsiesees 20 x bis 500 x

FlimmerfreqUeNZ...........ouveveunivniininesisieieinne 50/60 Hz

Bildformat .......c.covvreerreeeee JPG

Videoformat ..o AVI

Videobildrate............ocrerieriinininineieieieens max. 30 fps

WeiRabgleiCh ... Automat

Lichtquelle ..., 8 x LED (weil)

Betriebsbedingungen.....

0 bis +70° C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)

Lagerbedingungen......... ..-5 bis +50 °C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)

Abmessungen (LxB x H).... 147 x 104 x 227 mm

GEWICHL. ... 760 g (mit Akku)

b) Netzteil

EINGANG ... 100 - 240 V/AC, 50/60 Hz
AUSGANG ..o 5VIDC, 1A

c) Software
Unterstltzte Betriebssysteme..........c..coccvvuuuee. Windows® Vista/7/8/10; Mac OS 10.9-10.13
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1. Introduction

Dear customer,
Thank you for purchasing this product.
This product complies with the statutory national and European requirements.

To maintain this status and to ensure safe operation, you as the user must observe these operating instructions!

handling. Also consider this if you pass on the product to any third party. Therefore, retain these operating

C These operating instructions are part of this product. They contain important notes on commissioning and
instructions for reference!

If there are any technical questions, please contact:

www.conrad.com/contact

2. Explanation of Symbols

The symbol with the lightning in the triangle is used if there is a risk to your health, e.g. due to an electric
shock.

operating instructions. Always read this information carefully.

& The symbol with the exclamation mark in the triangle is used to indicate important information in these
—>

The arrow symbol indicates special information and advice on operation.

3. Intended Use

This product is a standalone device powered by rechargeable battery. It can output a magnified image through the
built in LCD display, television or a computer monitor. It is suitable for examining solid objects such as coins, stamps,
rocks, insects, plants, textiles, circuit boards, etc. Dimmable LED lights provide brightness, and the bundled software
allow the user to calibrate the microscope, and measure captured images.

It is intended for indoor use only. Do not use it outdoors. Contact with moisture, e.g. in bathrooms, must be avoided
under all circumstances.

For safety and approval purposes, you must not rebuild and/or modify this product. If you use the product for purposes
other than those described above, the product may be damaged. In addition, improper use can result in short circuits,
fires, electric shocks or other hazards. Read the instructions carefully and store them in a safe place. Make this
product available to third parties only together with its operating instructions.

All company names and product names are trademarks of their respective owners. Al rights reserved.
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4. Delivery Content

+ Main unit + USB cable
+ Power adaptor + AV cable
+ Calibration ruler + Li-ion battery

+ Operating instructions

——> MicroSD card not included.

Up-to-Date Operating Instructions

Download the latest operating instructions at www.conrad.com/downloads or scan the QR code
shown. Follow the instructions on the website.

5. Features and Functions

3.5inches TFT panel

20x - 500x magnification

5 megapixel image sensor (12 M interpolated)
Photo and video

MicroSD card support (max. 32GB)
Rechargeable Lithium-ion Battery

Support for plug and play.

PortableCapture Plus software

6. System Requirements

0S: Windows?® Vista/7/8/10; Mac OS 10.9~10.13
CPU: Pentium 300 or compatible AMD Processor
100 MB free hard disc space

512 MB RAM

24-bit video card

Available USB 2.0 port
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7. Safety Instructions

N

28

Read the important information and operating instructions carefully and especially observe the
safety information. If you do not follow the safety instructions and information on proper handling,
we assume no liability for any resulting personal injury or damage to property. Such cases will
invalidate the warranty/guarantee.

a) General

The device is not a toy. Keep it out of the reach of children and pets.

Do not leave packaging material lying around carelessly. This may become dangerous playing material
for children.

Protect the device from extreme temperatures, direct sunlight, strong jolts, high humidity, moisture,
flammable gases, steam and solvents.

Do not place the product under any mechanical stress.

If it is no longer possible to operate the product safely, take it out of operation and protect it from any
accidental use. Safe operation can no longer be guaranteed if the product:

- is visibly damaged,
- is no longer working properly,
- has been stored for extended periods in poor ambient conditions or

- has been subjected to any serious transport-related stresses.

Please handle the product carefully. Jolts, impacts or a fall even from a low height can damage the
product.

Also observe the safety and operating instructions of any other devices which are connected to the
product.

Consult an expert when in doubt about the operation, safety or connection of the device.

Maintenance, modifications and repairs must only be completed by a technician or an authorised repair
centre.

If you have questions which remain unanswered by the operating instructions, contact our technical
support service or other technical personnel.

Attention, LED light:
- Do not look directly into the LED light!

- Do not look into the beam directly or with optical instruments!

In schools, training facilities, hobby or self-service workshops, handling of electrical devices must be
monitored by trained personnel.

When operating on commercial premises, the relevant accident prevention regulations of workers’
compensation boards for electrical equipment must be observed.

b) Rechargeable Battery

+ Correct polarity must be observed while inserting the rechargeable battery.

+ The rechargeable battery should be removed from the device if it is not used for a long period of time to
avoid damage through leaking. Leaking or damaged rechargeable battery might cause acid burns when
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in contact with skin, therefore use suitable protective gloves to handle corrupted rechargeable battery.

+ Rechargeable battery must be kept out of reach of children. Do not leave rechargeable battery lying
around, as there is risk, that children or pets swallow them.

+ Rechargeable battery must not be dismantled, short-circuited or thrown into fire. Never recharge non-
rechargeable battery. There is a risk of explosion!

+ Do not charge the rechargeable battery via mains power supply while the microscope is connected to a
powered USB 2.0 port. This may cause the battery to overheat.
c¢) Adaptor

The mains outlet must be located near to the device and be easily accessible.

As power supply, only use the supplied mains adaptor.

Only connect the power adaptor to a normal mains socket connected to the public supply. Before
plugging in the power adaptor, check whether the voltage stated on the power adaptor complies with the
voltage of your electricity supplier.

Never connect or disconnect power adaptors if your hands are wet.

Never unplug the power adaptor from the mains socket by pulling on the cable; always use the grips
on the plug.

When setting up the product, make sure that the cable is not pinched, kinked or damaged by sharp
edges.

Always lay the cables so that nobody can trip over or become entangled in them. This poses a risk of
injury.
For safety reasons, disconnect the power adaptor from the mains socket during storms.

d) Microscope

Do not examine objects with temperatures outside the given operating temperature range of the product.

Sudden temperature change may form dew inside the Microscope like entering a warm room in cold
winter. Put it inside a handbag or plastic bag to slow down temperature changes.

Do not point Microscope lens to the sun or strong light for a long time. Powerful light may damage the
light-sensitive electronics.

Do not force the card into the slot as this may damage the microscope and the MicroSD memory card.

The base of the microscope may leave marks on sensitive surfaces.

e) Protection Against Dust

+ Dust and debris from the air can lead to deterioration of image quality. Keep the Microscope away from
dusty environments.

+ The opening of the camera lens should always be protected either with dust covers such. Suitable
options include aluminium foil or plastic bags.

« If dark specks or similar in-focus artifacts are observed in digital images, and they are not in the specimen
plane, their most likely cause is particulate contamination on the image sensor or an associated filter
surface. The cameras always need to be handled with the utmost care and protected from dirt according
to the manufacturer‘s recommendations.

+ Before every critical use, check the front lens of the objective for dirt.

29



8. Operating Elements

a) Control Panel

A= =N
o) 000 1B3/1E1S
= SN
A & ) LED Dimmer
L D
X185
MicroSD Card Slot— p-Zoom In/Out
v
Playback/Left Power ON/OFF
Menu Setup Down
Confirm Colour Mode / UP

b) LCD Display Icons

ICON DESCRIPTION
@/ E Still image / video mode
@ Timer mode

d]] cﬂ @rﬂ Images taken / remaining (based on current image resolution and MicroSD card size).

)

MicroSD inserted

5. O] Current image resolution
Battery level
Xﬂ 5 Digital zoom level
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¢) Microscope

Al A1l // 4
\ A2 A12—7F"
©
©
@ )
©
‘ A6
S| Mr
O I
j—; —;
A1 3.5 display A9  AV-out television cable port
A2 MicroSD card slot A10 USB 2.0 Mini-B
A3  Fine focus dial A11 LED brightness adjust
A4 Object stage A12 Digital zoom +/-
A5  Coarse focus (unlock / lock) A13 Camera lens / LED light source
A6  Battery indicator LED A14 Coarse focus (up / down)
A7 Image capture button A15 Battery compartment

A8  5VIDC charging port

& The rubber feet on the base of the microscope may leave marks on sensitive surfaces.
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9. Setting Up the Microscope

a) Insert Battery
+ Match polarity as shown in the battery compartment (A15).
=

b) Charge Battery

Do not charge the battery via mains power supply while the microscope is connected to a powered USB
2.0 port. This may cause the battery to overheat.

+ The battery will charge via USB cable or mains
power supply.

‘ - Connect the supplied charging cable to the
00 5VIDC charging port (A8) at the back of the
/ base, and the other end to a power outlet.

=)

- Or connect the supplied USB cable to the
USB port (A10) at the back of the base,
and the other end to the USB port on your
computer.

+ The battery indicator LED (A6) will glow red to
indicate that the battery is charging, and turn off
when the battery is fully charged.

* When it is time to recharge the battery, a low
battery icon will show on the bottom right corner
of the LCD display.
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c) Insert MicroSD Card
Do not force the card into the MicroSD card slot (A2) as this may damage microscope and the memory
card. The MicroSD memory card must be formatted before use (see section 11.c General / Format SD).

+ If you wish to use the microscope untethered to a computer, you
must insert a MicroSD card (not included)

+ Disconnect and turn the microscope OFF.

+ Insert the MicroSD card as shown below.

—> See section “12. Connect to Computer” for information about connecting the microscope to a computer.

10. Operation

& Do not cover the microscope when it is in use.

a) Power ON / OFF

« Press the power (1) button to turn the microscope ON or OFF.

b) Focus the Microscope

+ Place the object to be examined onto the stage (A4). If observing slides or similar, insert under the stage clips.
+ While holding the coarse focus (A14) in place, release the coarse focus lock (A5).

+ Rotate the coarse focus dial (A14) to lower the lens towards the object.

+ Adjust the fine focus dial (A3) to bring the image into sharp focus.

— It may take a few moments for the white balance to auto adjust and bring the image into focus. If there is
too much reflection from the object, consider lowering the LED brightness or turning it off completely.

c) High and Low Magnification
+ Center the lens (A13) over the object.

+ High magnification: Turn the fine focus dial (A3) all the way to the right, then slowly dial back until the image comes
into focus.

+ Low magnification: Turn the fine focus dial (A3) all the way to the left, then slowly dial back until the image comes
into focus.

—> After turning the fine focus dial (A3) all the way right or left, it will take a few seconds for the LED light
balance to adjust.
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d) Digital Zoom
+ First bring the object into focus on the LCD display (A1).
+ Zoom in or out of the object by adjusting the zoom wheel = b + (1x - 4.0x).

e) Photo / Video Capture
+ Press © o switch between photo and video modes
- An[BJicon on the LCD display indicates that you are in Photo mode.
- An]=licon on the LCD display indicates that you are in Video mode.
+ Press the image capture button (2] to take photo or begin recording video.

+ If recording a video, press the image capture button (2] again to stop recording.

f) Photo / Video Preview
+ Press the D A button to enter playback mode.
+ Press A or ¥ to select a photo or video for viewing.
- AnH icon on the LCD display indicates that it is a video.
- AnPJicon on the LCD display indicates that it is a photo.
+ Press OK to playback a video.

g) Playback Options
+ Press the > A button to enter playback mode.
+ Press A or ¥ to select a photo or video for viewing.
« Press ¥ to enter the sub-menu, then press A or 'V for further options such as:
- Delete: Deletes image.
- Protect: Locks one or all images to prevent them from accidentally being deleted.
- Slide Show: Cycles through all saved photos. The show ends after all photos have shown.

+ Press OK to select.

h) Color Modes

+ In photo mode (@], change color modes by pressing the (M A button to cycle between (colour/ positive / negative).

—> You cannot change color modes for video recording.
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11. Microscope Menu Options

+ To access photo or video settings, first press > < to select a mode.
- An [©Jicon on the LCD display indicates that you are in Photo mode.
- Anlicon on the LCD display indicates that you are in Video mode.
« Press Y to enter settings.
+ Press © < to switch between camera and general settings.
+ Press A or ¥ to select up or down, press OK to select an option.

« Press Y to exit the settings.

a) Camera [©

+ Time Lapse:
- Frames: Set the total number of images to be taken.
- Duration: Set the interval between images taken (hh:mm:sec).
- Press " to exit the settings.

- Time lapse will automatically start and the LCD will show the time lapse icon =

- Time lapse will finish after the total number of images have been taken, by pressing OK, or pressing 153}

Sharpness: Software sharpen the image on the LCD display (Hard, Normal, Soft).

b) Video |3
+ Resolution: Switch resolution (VGA or QVGA)

c) General %
+ Language: Set display language
+ Power Save: Set the auto shut off time if no keys are pressed (5, 10, 15) minutes.

+ Frequency: Change the flicker frequency 50 Hz or 60 Hz.

Date Stamp:

- First go to “Date/Time” and set the current time and date.

- Setting “Date/Time” will apply a date and time stamp to all your photo and video recordings.

« TV Out: Select between PAL or NTSC.

Date/Time: Set the current date and time.

+ Format SD: Erases all images on SD card / prepares new SD card for use.

Sys. Reset: Restores all settings to factory defaults.

Version: Indicates the installed firmware version.

Resolution: Change the image resolution. The higher the resolution the more memory space each image takes.
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12. Connect to Computer

Using the bundled "PortableCapture Plus” software, you can preview images on your computer, take full control of
your microscope and more. See section “PortableCapture Plus Sofware” for further information.

+ Connect one end of the supplied USB cable to the USB port fine focus dial (A10) on your microscope, and the other
end to an available USB 2.0 port on your computer.

+ Press the power (D) button to turn the microscope ON.
+ Press A or ¥ and select PREVIEW ON COMPUTER, then press OK.

+ Run the software by clicking the “PortableCapture Plus” icon generated on the desktop after installation.

—> When controlling the microscope through the computer sofware the hardware buttons will be disabled as
most of functions are available through the “PortableCapture Plus” software.
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13. Download and install software

a) Windows® Installation

Portable Stand Alone
LCD Digital Microscope

Instal PortableCapture
User's manual

Broze tha G0

1. Visit: www.conrad.com/downloads .

2. Enteritem number 1713199 .

3. Select Install PortableCapture to install the software, then follow the on-screen instructions to complete the
installation process.

4. Run the software by clicking the PortableCapture Plus icon generated on the desktop after installation.
—>  Ifneeded change the display language e.g. Options > Language > English.

b) Mac OS Installation

. Visit: www.conrad.com/downloads .

. Enter item number 1713198.

. Select the file PortableCapture Plus.pkg file.

. Follow the on screen instructions to complete the installation process.

. Run the software by clicking the PortableCapture Plus icon generated on the desktop after installation.
—>  Ifneeded change the display language e.g. Options > Language > English.

S R R N
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c¢) Overview

£) PortableCapture Plus
Bl —————"= options Capture

827%? @ @ & & Magnification: None B

Photo | Video

W

180814180443732pg

B7

B4

6407480

B1 Menu items
- File > Photos / Videos Folder: Where captured images are stored on your computer.
- Options > Resolution: Change image capture resolution.
- Options > Date /Time: Show/hide the recorded date and time in photo or video.
- Options > Language: Change user interface language.
- Options > XY Guide: Show/hide guidelines.
B2 Shortcuts: Camera / Video / Timer / Full Screen.

(SIS
Enter / exit full screen mode by double-clicking the preview area or selecting the full screen icon.
B3 Xand Y axis guidelines.
B4 Image preview area.
B5 Magnification information.
B6 Photo / Video tab: Select a tab to view saved Photos or Videos.
B7 Saved images window (thumbnail view).
- Captured images / videos show up as thumbnails.
- If you hover the mouse over a thumbnail, the image will show in the preview area (B4).

- Right mouse click an image for further options such as Open, Save as, Copy, Delete, Delete All.
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d) Take Photo

+ Adjust the microscope so that the camera lens (A3) is close to and pointing at the object.

+ Make sure the object to be examined is centered under the lens.

+ While observing the image preview area (B4), bring the image into focus.

+ To capture the image select the camera shortcut icon (g, or press the image capture button (A7).

+ Photos will be stored in File > Photos Folder.

——> Captured images show as thumbnails in the saved images window (B7). If you hover the mouse over a
thumbnail, the image will show in the preview area (B4). Images are stored in the JPG format.

e) Record Videos

+ Adjust the microscope so that the camera lens (A3) is close to and pointing at the object.

+ Make sure the object to be examined is centered under the lens.

+ While observing the image preview area (B4), bring the image into focus.

« To start recording select the Video shortcut icon &/. The icon will flash to indicate recording has started.
+ Click the flashing icon to stop recording.

+ Videos will be stored in File > Videos Folder.

—> Captured videos show as thumbnails in the saved images window (B7). If you hover the mouse over a
thumbnail, the image will show in the preview area (B4). Videos are stored in the AVI format.

f) Photo and Video Timer

2 Timer « | * You can set a custom start and stop timer for capturing photos or recording
video.

@® Photo O Video

Startfime + Select the Timer shortcut (&), then choose Photo or Video.
Interval(seck Dl

_ + Set your desired parameters.
Video time(sec): 10 -
Total Humber + Select Start, to begin recording.

s ril| —> Recording will stop after the program has run through the parameters,
Ll or if you select Stop to end the timer. Make sure you have enough
memory space on your hard disc before recording.
Start Stop
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g) Image Measuring Tools

For measuring tools to be accurate, first calibrate your microscope. See section “14. Calibrating the
Microscope” for information about how to do this.

—> Double-click an image in the saved images window (B7) to enter the measurement interface, then select
the measure Z77 icon.

— * Any Angle Line Measurement. Click and drag from one point to another.
=]

Continuous Line Measurement. Click and drag from one point to multiple
points.

Any Angle Line

BT TE R Radius Circle Measurement. Click and drag to extend the radius.

=
I3
(%) Radius Circle
&
L

Diameter Circle Measurement. Click and drag to extend the diameter.
Diameter Circle + Three Points Angle Measurement. Click and drag from one point to

another, measure the angle, then click the mouse to release.
Three Points Angle 9

Line Properties ]

h) Draw and Text

—> Double-click an image in the saved images window (B7) to enter the Image Markup / Comment interface,
then select the draw & icon.

y j + Adropdown menu will show with various options.
7 % Line
Arrow

Freehand

O

Rectangle

Line Properties 3

+ Line Properties include Line Width and Line Color.

[—smidnne v]

2 % Line Width

[ Line Calor
ﬁ + To modify text options, select the text T icon.
-
+ Adropdown menu will show with various options such as font selection and
text color.

T Choose Font
Il et Color
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14. Calibrating the Microscope

+ Focus the microscope on the calibration ruler.

HWHWIUH

Oin

m;wwlum ‘k
N |

mm nnvs 01 02 03 04 05

+ Rotate the fine focus dial (A3) until the picture becomes sharp.

Calibration Ruler Lme

BER

Adjust the ruler position so the image is lined up
square with the XY guide lines.

—> Double-click an image in the saved images window (B7) to enter the measurement interface, then select
the calibration ~ icon.

[@0eeees 7 T e pr— + Click and drag to select start and end points across

| a known value e.g. 1 mm increment along the ruler.

+ When the dialog box shows, enter the exact value of
the measurement sample in the Actual dimension
field. The software will calculate the magpnification.

+ Select OK to confirm. The adjusted magnification
value will show in the upper right corner.
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15. Connect to Television

You can use your television screen as a large display for viewing magnified objects.

+ Connect the supplied AV cable to the AV-out television cable port (A9) on the microscope, and the other end to the
video input on your television.

Press the power (1) button to turn the microscope ON.

+ Press © < to switch between photo or video modes.
- An ([BJicon on the LCD display indicates that you are in Photo mode.
- An]=icon on the LCD display indicates that you are in Video mode.

+ Press % to enter the microscope settings.

+ Press © o switch to “Setup’.

+ Press A or ¥ and select “TV Out”, then press OK.

« Press A or ¥ and select “NTSC” or “PAL”, then press OK.

+ Press % to exit the microscope seftings.

Select the appropriate input channel on your television.

—> Refer to your television operating manual for information about where to locate the video inputs, and how
to select the input channel screen.

16. Image Backup (USB Mode)

——>  You can save images directly to your computer without going through the bundled software.

+ Connect one end of the supplied USB cable to the USB port (A10) on your microscope, and the other end to an
available USB 2.0 port on your computer.

Press the power (1) button to turn the microscope ON.

+ From the menu select UPLOAD IMAGES, then press OK. The microscope will appear on your computer as an
external USB storage device USBSTORAGE.

Select the applicable drive letter and navigate to the folders named PHOTO or VIDEO to access your saved images.

+ Copy images to the desired location on your computer.
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17. Care and Cleaning

+ Disconnect the product from your computer before each cleaning. If it is hot, wait for it to cool down.

+ Do not use any aggressive cleaning agents, rubbing alcohol or other chemical solutions as they can cause damage
to the housing and malfunctioning.

+ The LED lights are not replaceable.
+ Avoid touching the lens with any substance. Clean the lens periodically with low pressure compressed air.

+ Clean the product with a dry, fibre-free cloth.

18. Disposal

a) Product

Electronic devices are recyclable waste and must not be disposed of in the household waste. At the end
of its service life, dispose of the product in accordance with applicable regulatory guidelines. Remove any
mmmm [Nserted rechargeable batteries and dispose of them separately from the product.

b) Rechargeable Batteries

You as the end user are required by law (Battery Ordinance) to return all used rechargeable batteries.
Disposing of them in the household waste is prohibited.

Contaminated rechargeable batteries are labeled with this symbol to indicate that disposal in the domestic
waste is forbidden. The designations for the heavy metals involved are: Cd = Cadmium, Hg = Mercury,
Pb = Lead (name on (rechargeable) batteries, e.g. below the trash icon on the left).

Used rechargeable batteries can be returned to collection points in your municipality, our stores or wherever
rechargeable batteries are sold.

You thus fulfill your statutory obligations and contribute to the protection of the environment.
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19. Technical Data

a) Microscope

POWET SOUFCE.......couivriieiireieieieeieceeeieieeieeaa Li-lon 3.7 V/1050 mAh (rechargeable battery)
5VIDC, 500 mA (USB 2.0)

Battery charge time Approx. 2 hrs (via power adapter)

Battery life Approx. 2 hrs

MEMOTY.....oveiericrie e microSD (max. 32 GB)

LCD DiSplay........ccuuiuireeniieineisiscreieeieens 7.6 cm (3") TFT, 4:3 ratio

IMAJE SENSOT ... 5MP

Video resolution............cceeeeeieinrecrneireis VGAI

Camera reSolUtion .............ceeeeneerereneeenenins 12M (4032 x 3024), 9M (3456 x 2592), 5M (2560 x 1920),
3M (2048 x 1536),1.3M (1280 x 960)

COlOT oo 24-bit RGB

FOCUS raNGE......vvuvrirrieieciceienier e 10 mm (manual focus)

Magnification ..o 20x to 500x

Flicker-frequency ... 50/60 Hz

Image format ..o JPG

Video format .......cooveeverencereeneieceeseeeeens AVI

Video frame rate .......ccoeveecenienenesieieeens Max. 30 fps

White balance...........ccccccveniiiniicnincinie Automatic

8 x LED (white)
0to +70 °C; 25 - 50 % relative humidity (non-condensing)

.-5t0 +50 °C; 25 - 50 % relative humidity (non-condensing)
147 x 104 x 227 mm
............................................................... 760 g (with battery)

................................................................... 100 - 240 V/AC, 50/60 Hz
5VIDC, 1A

c) Software
Supported operating systems...........ccccoovveunn Windows® Vista/7/8/10; Mac OS 10.9~10.13
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